
Q.1 Who among the following inaugurated the 38th National Games held in Dehradun in
January 2025?

Ans 1. Droupadi Murmu

2. Pushkar Singh Dhami

3. Narendra Modi

4. Anurag Thakur

Q.2 The fine powder that is obtained from the modified and recycled form of plastic is called
_______.

Ans 1. polyethylene

2. polystyrene

3. polyblend

4. polythene

Q.3 Which of the following is a characteristic difference between colloids and true
solutions?

Ans 1. True solutions exhibit Brownian motion, but colloids do not.

2. True solutions show the Tyndall effect, but colloids do not.

3. True solutions have visible solute particles, whereas colloids have invisible dispersed particles.

4. True solutions have a single-phase system, whereas colloids have a two-phase system.

Q.4 What is the shortcut key to start a slideshow from the beginning?
Ans 1. Ctrl + P

2. F5

3. Shift + F5

4. Alt + Tab

Q.5 Which of the following is NOT a source of release of smokestacks?
Ans 1. Thermal power plants

2. Rivers

3. Industries

4. Smelters
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Q.6 What is India's global military ranking in the 2025 Global Firepower (GFP) index?
Ans 1. 4th

2. 2nd

3. 5th

4. 3rd

Q.7 In an electric circuit, what is the correct way to connect an ammeter?
Ans 1. In series with the component

2. In parallel with the component

3. In either series or parallel

4. In parallel with the source

Q.8 Which state of matter shows the highest expansion when temperature is increased?
Ans 1. Solids

2. Liquids

3. Gases

4. Plasma

Q.9 What is the primary purpose of using a firewall on a Personal Computer?
Ans 1. To clean up temporary files

2. To increase storage space

3. To speed up internet connectivity

4. To block unauthorised access and protect the computer

Q.10 If an object is dropped from rest, what will be its velocity after 15 seconds? (g = 9.8
m/s²)

Ans 1. 147 m/s

2. 145 m/s

3. 149 m/s

4. 143 m/s

Q.11 Which of the following companies announced plans in February 2025 to construct the
world's longest undersea cable, aiming to enhance internet connectivity across five
continents, with landing points in India?

Ans 1. Microsoft

2. Google

3. Amazon

4. Meta

Q.12 What is the maximum number of Ministers allowed in the Council of Ministers, including
the Prime Minister, as per the 91st Amendment Act?

Ans 1. 20% of Lok Sabha strength

2. 15% of Lok Sabha strength

3. 10% of Lok Sabha strength

4. 12% of Lok Sabha strength

Q.13 Which of the following is the correct way to insert a new column in a spreadsheet?
Ans 1. Go to Home > Insert > Insert Sheet Columns.

2. Go to File > New > Column.

3. Press Ctrl + X and then Insert.

4. Use Ctrl + Z to insert a column.



Q.14 What was the main objective of the Extremists during the Indian National Movement?
Ans 1. To expand the legislative councils

2. To bring social reforms

3. To promote British goods in India

4. To attain complete independence (Swaraj)

Q.15 According to the Tendulkar methodology, what was the estimated percentage of people
below the poverty line in rural areas in 2011-12?

Ans 1. 15.5%

2. 20%

3. 25.7%

4. 27.5%

Q.16 Inertia depends on which property of an object?
Ans 1. Acceleration

2. Velocity

3. Shape

4. Mass

Q.17 Which of the following is NOT toxic to non-target organisms in the soil?
Ans 1. Organic fertilisers

2. Herbicides

3. Pesticides

4. Fungicides

Q.18 What is the first step to securing ones smartphone or tablet?
Ans 1. Setting a password/PIN-protected lock screen

2. Installing more apps

3. Turning off mobile data

4. Using only free Wi-Fi networks

Q.19 The phenomenon of multiple echoes due to repeated reflections is called ___________.
Ans 1. diffraction

2. resonance

3. reverberation

4. refraction

Q.20 What is the primary function of the F4 key in MS Excel when editing a cell reference in a
formula?

Ans 1. Opens the Find and Replace dialog

2. Toggles between absolute and relative references

3. Repeats the last action

4. Refreshes the worksheet

Q.21 The glass panel used in greenhouses is known to retain ________.
Ans 1. heat

2. humidity

3. pH

4. rainfall



Q.22 Which of the following CANNOT be considered as a measure to control global
warming?

Ans 1. Causing deforestation

2. Reduction in emission of greenhouse gases

3. Efficiently using energy

4. Cutting down use of fossil fuel

Q.23 The primary agent that helps in the decomposition of biodegradable matter in domestic
sewage is __________.

Ans 1. chloride

2. phosphate

3. bacterium

4. nitrate

Q.24 Why does a bee sting cause pain and irritation?
Ans 1. The sting injects a mild sugar solution.

2. The sting contains a strong base.

3. The sting injects methanoic acid.

4. The sting releases carbon dioxide gas.

Q.25 What is the purpose of the Collation option in the Print settings?
Ans 1. To adjust the page orientation

2. To select a custom print range

3. To change the printer selection

4. To print all the pages of a document as a set

Q.26 The Rudra Veena is predominantly associated with which genre of Hindustani music?
Ans 1. Ghazal

2. Khayal

3. Thumri

4. Dhrupad

Q.27 If you want the primary recipient to see that others have received a copy of an email,
you should enter their email addresses in the ______ field.

Ans 1. Cc

2. Subject

3. Bcc

4. To

Q.28 If the absolute refractive index of a medium is less than 1, it means ________.
Ans 1. the medium absorbs all light

2. light travels slower in that medium than in vacuum

3. light travels faster in that medium than in vacuum

4. the medium is a perfect reflector

Q.29 Dr. BR Ambedkar described which part of the Indian Constitution as its ‘novel features',
while Granville Austin referred to it as the ‘Conscience of the Constitution’?

Ans 1. Preamble

2. Fundamental Duties

3. Directive Principles of State Policy

4. Fundamental Rights



Q.30 Which of the following correctly represents the chemical formula of a compound
formed by aluminium and sulphate ions?

Ans 1. Al₂(SO₄)₃
2. Al₃(SO₄)₂
3. Al(SO₄)₃
4. Al₂SO₄

Q.31 Which official in the Gupta administration was responsible for peace and war matters?
Ans 1. Mahadandanayaka

2. Sandhi-Vigrahika

3. Mahapratihara

4. Vishayapati

Q.32 What is the net force acting on an object if balanced forces are applied?
Ans 1. Infinite

2. Equal to acceleration

3. Zero

4. Equal to the mass of the object

Q.33 Which of the following is NOT a component of a CPU?
Ans 1. Hard Disk

2. Cache Memory

3. Control Unit (CU)

4. Arithmetic Logic Unit (ALU)

Q.34 Which Article provides Ministers the right to participate in parliamentary proceedings
but without voting rights?

Ans 1. Article 53

2. Article 77

3. Article 88

4. Article 78

Q.35 Which of the following cities hosted the inaugural Kho Kho World Cup in January 2025?
Ans 1. New Delhi

2. Chennai

3. Mumbai

4. Kolkata

Q.36 Identify the correct formula for the compound formed between Mg²⁺ and PO₄³⁻ ions.
Ans 1. Mg₂(PO₄)₃

2. Mg₃(PO₄)₂

3. Mg(PO₄)₃

4. MgPO₄

Q.37 Which of the following states is NOT covered under the Atal Bhujal Yojana?
Ans 1. Maharashtra

2. Uttar Pradesh

3. Rajasthan

4. Jharkhand



Q.38 What does PCB stand for?
Ans 1. Processing Circuit Board

2. Primary Control Board

3. Peripheral Connection Bus

4. Printed Circuit Board

Q.39 Which of the following correctly explains why clothes dry faster on a windy day?
Ans 1. Wind decreases the temperature of the water molecules.

2. Wind reduces the surface area of the clothes.

3. Wind increases the humidity around the clothes.

4. Wind removes the water vapour from the clothes’ surroundings.

Q.40 In which of the following regions the Himalayas has the greatest width?
Ans 1. Himachal Pradesh

2. Arunachal Pradesh

3. Kashmir

4. Sikkim

Q.41 The practice of Jhum cultivation is prevalent in the __________.
Ans 1. South east

2. North east

3. South west

4. North west

Q.42 The energy that is derived from the use of radioactive isotopes is termed as _________.
Ans 1. solar energy

2. geothermal energy

3. thermal energy

4. nuclear energy

Q.43 What is the approximate pH of a neutral salt solution?
Ans 1. Depends on the temperature

2. Equal to 7

3. More than 7

4. Less than 7

Q.44 Which defect of vision occurs due to the weakening of ciliary muscles with age?
Ans 1. Presbyopia

2. Astigmatism

3. Hypermetropia

4. Myopia

Q.45 The Millennium Development Goals (MDGs) aimed to reduce extreme poverty by which
year?

Ans 1. 2008

2. 2005

3. 2014

4. 2015



Q.46 The Industrial Policy Resolution of 1956 categorised industries into how many groups?
Ans 1. Nine

2. Seven

3. Three

4. Five

Q.47 What happens when a computer is put into Sleep mode?
Ans 1. It stores data on the hard drive and powers off.

2. It keeps the session active in RAM while using minimal power.

3. It shuts down completely.

4. It restarts automatically after a few minutes.

Q.48 What happens when an acid reacts with a metal oxide?
Ans 1. A salt and water are formed.

2. Only water is formed.

3. A salt and hydrogen gas are formed.

4. Only salt is formed.

Q.49 The main use of chlorofluorocarbons is in __________.
Ans 1. refrigerants

2. smog

3. chimneys

4. vehicles

Q.50 The maximum sound is generated _________.
Ans 1. from industrial smoke

2. from vehicular emissions

3. by the take off of a jet plane

4. from house chimneys

Q.1 Which type of footing is preferred for closely spaced columns in a row? 
Ans 1. Continuous footing

2. Combined footing

3. Strap footing 

4. Isolated footing

Q.2 Which of the following sensors on board of the Indian Remote Sensing satellites is
capable of monitoring dynamic phenomenon such as forest fire?

Ans 1. PAN

2. LISS I

3. WiFS

4. MOS

Q.3 Which of the following statements about traffic marking classification is INCORRECT?
Ans 1. Longitudinal markings regulate lane discipline and provide guidance to drivers.

2. Transverse markings include stop lines, pedestrian crossings and yield lines.

3. Yellow markings are exclusively used for regulatory purposes, while white markings are only used for guidance.

4. Object markings are used to indicate fixed roadside obstacles like medians and bridge piers.
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Q.4 Which type of footing is most commonly used when a column is placed near a property
boundary, restricting footing extension on one side?

Ans 1. Strap footing

2. Isolated footing

3. Combined footing

4. Mat footing

Q.5 A Location Plan is also called a:
Ans 1. Key Plan

2. Survey Plan

3. Site Plan

4. Master Plan

Q.6 The term 'eccentric footing' refers to a footing:
Ans 1. placed off-centre relative to the column

2. shared by multiple columns

3. used for machine foundations

4. having a circular shape

Q.7 Which of the following boundary conditions for a column results in the lowest effective
length factor (K)?

Ans 1. Both ends fixed

2. One end fixed and the other free

3. One end fixed and the other pinned

4. Both ends pinned

Q.8 According to the Bureau of Indian Standards, IS 12894:2002, clay and silt in sand for
pulverized fuel-ash lime bricks should preferably be:

Ans 1. 11-15%

2. 16-20%

3. 6-10%

4. 0-5%

Q.9 Which of the following is NOT a desirable characteristic of a good formwork?
Ans 1. Should provide a smooth surface finish

2. Should be easily handled and removed

3. Should be rigid and strong

4. Should be highly absorbent to absorb excess water

Q.10 Which type of window sill is best suited for areas prone to heavy rainfall?
Ans 1. Sloped sill

2. Vertical sill

3. Horizontal sill

4. Flat sill

Q.11 A finish of rich concrete made with very hard and tough quality coarse aggregate such
as granite, basalt, quartzite, etc. is known as _____ finish.

Ans 1. ceramic

2. terrazzo

3. monolithic

4. granolithic



Q.12 In a reinforced concrete beam, what should the spacing of vertical stirrups be in terms
of effective depth, to ensure adequate shear reinforcement as per IS 456:2000?

Ans 1. It should not exceed 0.75 times the effective depth (d) of the beam.

2. It should not exceed twice the effective depth (d) of the beam.

3. It should not exceed the effective depth (d) of the beam.

4. It should not exceed 1.5 times the effective depth (d) of the beam.

Q.13 A building section drawing does NOT give which of the following information?
Ans 1. Height of the structure

2. Foundation used for the structure

3. Length and width of the rooms

4. Type of materials used for the structure

Q.14 Which keyboard shortcut is used to toggle wireframe mode in 3ds Max?
Ans 1. F3

2. Ctrl + W

3. W

4. Shift + X

Q.15 In the three envelope system of tender submission, the first envelope contains:
Ans 1. technical bid

2. documents related to eligibility criteria

3. financial bid

4. documents related to estimation of construction work

Q.16 For a column with one end fixed and the other end hinged, what is the effective length
factor K?

Ans 1. 0.5

2. 1.0

3. 2.0

4. 0.7

Q.17 Which of the following components of the Autodesk Civil 3D 2024 user interface
provides access to file-related commands such as creating, opening, printing, exporting
and publishing files?

Ans 1. Command Line

2. Toolspace Window

3. Application Menu

4. Ribbon

Q.18 If the width of a rectangular notch is doubled, then the discharge will _______.
Ans 1. double

2. become half

3. remain the same

4. increase by three times

Q.19 Expanded polystyrene (EPS) is commonly used in the construction of:
Ans 1. reinforced concrete

2. structural steel

3. thermal insulation panels

4. electrical wiring



Q.20 Which of the following is a major combustible component of biogas?
Ans 1. Carbon dioxide

2. Hydrogen sulphide

3. Methane

4. Butane

Q.21 A light pole is held in place by three tensioned cables forming angles of 60°, 75°, and
45° with each other at a common point. Assuming equilibrium, which theorem helps to
determine the tensions in the cables?

Ans 1. Varignon’s theorem

2. Parallel axis theorem

3. Lami’s theorem

4. Newton’s second law

Q.22 What are beams fabricated using rolled plates called?
Ans 1. Plate girders

2. Castellated beams

3. Hybrid beams

4. Composite beams

Q.23 Why is proper drainage essential for subgrade soil in highway pavements?
Ans 1. To prevent moisture retention and strength reduction

2. To reduce erosion

3. To increase soil temperature

4. To allow easy mixing with cement

Q.24 Which of the following statements is true regarding a fixed beam?
Ans 1. The deflection and slope at the fixed end are zero.

2. A fixed beam is always supported on more than two supports.

3. A fixed beam does not experience end moments

4. The deflection at the fixed ends is zero, but the slope is not zero.

Q.25 Which of the following is NOT a type of drilling equipment?
Ans 1. Truck mounted drill

2. Jack hammer

3. Drifters

4. Excavator

Q.26 Which method is most commonly used for placing concrete in high-rise buildings?
Ans 1. Direct placement using wheelbarrows

2. Hand mixing and placing

3. Pouring concrete from a height without any control

4. Pumping method

Q.27 Which of the following statements about manometric head is correct?
Ans 1. It is the effective head that accounts for losses.

2. It represents only the suction head of a pump.

3. It does not include friction losses.

4. It is a constant value for all pumps.



Q.28 The correct relationship between Modulus of Elasticity (E) and Shear Modulus (G) is
given by:

Ans 1. E = 3G(1−2μ)

2. E = G(1+μ)

3. E = G(1+2μ)

4. E = 2G(1+μ)

Q.29 What is the main purpose of applying grade compensation on a horizontal curve?
Ans 1. To increase the tractive effort of vehicles

2. To make the road surface smoother

3. To reduce the frictional resistance due to the curve and gradient

4. To allow vehicles to travel at higher speeds on curves

Q.30 With respect to Darcy's law, which of the following heads are ignored for soil flow
problems?

Ans 1. Hydraulic head

2. Datum head

3. Velocity head

4. Pressure head

Q.31 Which of the following bonds is considered the strongest and most suitable for load-
bearing walls?

Ans 1. Stretcher bond

2. English bond

3. Flemish bond

4. Header bond

Q.32 If the length, width and height of the wall is 7 m, 0.3 m, 3 m, respectively, then the total
quantity of brickwork required will be:

Ans 1. 21 m2

2. 6.3 m3

3. 0.9 m2

4. 12.6 m3

Q.33 What is the main purpose of adding steel fibres to concrete?
Ans 1. To reduce the need for cement

2. To increase the water cement ratio

3. To increase the weight of concrete

4. To improve its tensile strength and crack resistance

Q.34 According to Terzaghi's bearing capacity theory, the angle of shear failure planes of the
Rankines passive zones of linear shear, with the horizontal is _____________. (where φ
= angle of internal friction)

Ans 1. 45 − φ/2

2. 45

3. 45 + φ/2

4. φ/2

Q.35 Which of the following causes settlement of foundations due to water level fluctuation?
Ans 1. Vibration due to blasting

2. Seasonal swelling and shrinking of expansive soils

3. Adjacent excavation

4. Slipping of ground strata on sloping sites.



Q.36 The vertical downward movement of a structure's base is known as _____.
Ans 1. Deformation

2. Deflection

3. Depression

4. Settlement

Q.37 Which of the following represents an engineer's scale?
Ans 1. 1 in 10

2. 1/5000

3. 1 cm = 10 m

4. 2%

Q.38 The devices for harnessing solar energy are usually coated with:
Ans 1. anti-reflective coating

2. anti-glare coating

3. carbide coating

4. titanium oxide coating

Q.39 Pointing is a process carried out in:
Ans 1. stucco walls

2. plastered masonry walls

3. exposed masonry walls

4. wattle and daub walls

Q.40 Escalator balustrades are primarily designed to:
Ans 1. protect users from falling

2. support the weight of steps

3. improve aesthetics

4. house control panels

Q.41 The aggregate crushing value in accordance with IS 2386 Part IV, 1963, shall not exceed
_____ for concrete for wearing surfaces such as runways, roads and pavements.

Ans 1. 35%

2. 45%

3. 30%

4. 50%

Q.42 As per general conditions of the contract, the security money deposited by the
contractor is:

Ans 1. 20% of the estimated cost

2. 10% of the estimated cost

3. 2% of the estimated cost

4. 5% of the estimated cost



Q.43 Where is the centre of gravity of a solid cone located?
Ans 1. At a height  from the base along the axis

2. At the geometric centre of the base

3. At a height  from the base along the axis

4. At the apex of the cone

Q.44 In polymer-modified concrete (PMC), the role of the polymer component is to:
Ans 1. increase setting time significantly

2. reduce water permeability and increase flexibility

3. reduce strength and durability

4. increase brittleness

Q.45 What is the function of the 'Layer Manager' in Autodesk 3ds Max?
Ans 1. To control object visibility and manage scene organisation

2. To assign materials to object

3. To group objects together

4. To add cameras to the scene

Q.46 Select the pair in which the words present the same relationship to each other as the
words of the given pair.

Approximate quantity estimate : Running meter length : : Cube rate estimate :
____________

Ans 1. plinth area

2. cubical content

3. cost of one room

4. area content

Q.47 Which structural component of a bridge directly supports the superstructure and
transfers the load to the foundation?

Ans 1. Deck

2. Expansion Joints

3. Bearings

4. Piers

Q.48 Which type of stone masonry uses stones of uniform size and shape?
Ans 1. Dry masonry

2. Ashlar masonry

3. Random rubble

4. Coursed rubble

Q.49 The whole circle bearing and the reduced bearing of a line will be the same when the
line is in the ________ quadrant.

Ans 1. north-west

2. north-east

3. south-east

4. south-west



Q.50 In plastering of surfaces, the process of hacking is done to ensure:
Ans 1. that the surface is smooth and free from all laitance

2. bonding between the surface and the plaster

3. that the materials of plaster are mixed to a correct consistency

4. that the moisture content is retained in the plaster mix

Q.51 A point on the picture plane where all the parallel lines appear to converge is called:
Ans 1. station point

2. vanishing point

3. eye level point

4. angle of vision point

Q.52 The moment of force depends on which factors?
Ans 1. The speed of rotation

2. Only the distance from the point of rotation

3. Both force magnitude and perpendicular distance

4. Only the magnitude of the force

Q.53 Which of the following factors would most likely decrease surface runoff?
Ans 1. Removal of vegetation

2. High intensity rainfall

3. Impervious surfaces like roads and buildings

4. Permeable soil and vegetation cover

Q.54 Cracks in buildings caused by vegetation are because of:
Ans 1. moisture due to transpiration of vegetation

2. the removal of vegetation leading to dry conditions

3. dense branches of trees adjacent to the building

4. the roots of trees very close to the building

Q.55 What is the main advantage of a raft foundation?
Ans 1. Reduces column spacing

2. Settlement is uniform

3. Easier to construct

4. Cheaper than other foundations

Q.56 Which of the following will NOT prevent cracks resulting from sulphate attack?
Ans 1. Use of bricks containing high percentage of soluble salts

2. Use of sulphate resistant cement in building works

3. Use of rich cement mortar or concrete in building works

4. Provision of damp proofing to maintain dry conditions

Q.57 Borosilicate glass is used in the manufacture of laboratory equipment and cooking
utensils due to what property?

Ans 1. It can withstand high temperatures.

2. It can be moulded into curved shapes.

3. It is a clear glass and does not obscure vision.

4. It is a strong glass and resists breakage.



Q.58 The foundation settlement caused by lowering of water level in fine grained soils is
_______.

Ans 1. consolidation

2. elastic compression

3. erosion

4. plastic compression

Q.59 For a thin rod of length L, rotating about its center, the radius of gyration is:
Ans 1. 

2. 

            

3. 

           

4. 

           

Q.60 In the moment distribution method, how is the distribution factor (DF) for a structural
member at a joint determined?

Ans 1. By multiplying the stiffness of the considered member at a joint with the total stiffness of all the members meeting at that joint

2. By dividing the total stiffness of all the members meeting at a joint by the stiffness of the considered member

3. By adding the stiffness of the considered member at a joint by the total stiffness of all the members meeting at that joint
           

4. By dividing the stiffness of the considered member at a joint by the total stiffness of all the members meeting at that joint

Q.61 Soil is composed of three layers of height 'h' m each. The permeability of layers are k,
2k, and k respectively. The equivalent permeability in vertical direction is:

Ans 1. 6k/5

2. 5/2k

3. 2k/5

4. 4k

Q.62 What is the typical ratio of cement, sand and aggregate for RCC (M20 grade)?
Ans 1. 1 : 4 : 8

2. 1 : 2 : 3

3. 1 : 3 : 6

4. 1 : 1.5 : 3

Q.63 In a reciprocating pump, which of the following options connects the piston to the
crankshaft?

Ans 1. Bearings

2. Suction pipe

3. Delivery pipe

4. Connecting rod

Q.64 Which type of reinforcement is called the main reinforcement in a one-way slab?
Ans 1. Top reinforcement supported along the longer span

2. Top reinforcement provided in the transverse direction

3. Bottom reinforcement placed in the longer span direction

4. Bottom reinforcement provided in the shorter span direction



Q.65 Which type of scaffolding is used for painting tall buildings?
Ans 1. Suspended scaffolding

2. Cantilever scaffolding

3. Double scaffolding

4. Single scaffolding

Q.66 Which tool is used for breaking hard surfaces during excavation?
Ans 1. Pickaxe

2. Crowbar

3. Rake

4. Spade

Q.67 What is the role of impact force in the soil compaction process?
Ans 1. It increases soil permeability.

2. It reduces the void spaces by sudden compression.

3. It creates a uniform soil texture.

4. It helps to retain moisture.

Q.68 The raw material for slate tile roofing is ______.
Ans 1. straw

2. metal

3. mud

4. stone

Q.69 Which of the following is NOT true with respect to structural cracks?
Ans 1. Pose significant risk to the stability of the building.

2. Generally the damage is difficult to rectify or repair.

3. Caused by changes in moisture, etc. on building materials.

4. Caused by overloading of the structural components.

Q.70 Which of the following is the full form of PENT or PETN, an explosive used in tunneling
and military applications?

Ans 1. Pentane Energy Nitrate

2. Polyethylene Nitrogen Trinitrate

3. Pyrotechnic Explosive Nitrogen Trigger

4. Pentaerythritol Tetranitrate

Q.71 Which of the following types of beams is used for lightly loaded beams such as roof
purlins and sheeting rails?

Ans 1. Angles sections

2. Castellated beams

3. Box girders

4. Plate girders

Q.72 Which type of roller is most suitable for compacting cohesive soils?
Ans 1. Vibratory roller

2. Smooth wheel roller

3. Pneumatic roller

4. Sheep foot roller



Q.73 Which of the following is the correct expression for the bending equation in pure
bending?

(Where M = Bending moment, I = Moment of inertia of the cross-section about the
neutral axis, f = Bending stress at a distance y from the neutral axis, y = Distance from
the neutral axis, E = Modulus of elasticity, and R = Radius of curvature of the beam)

Ans
1. 

           

2. 

           
           

3. 

            

4. 

           
           

Q.74 A prismatic bar of length 'L' and cross-sectional area 'A' is subjected to an axial tensile
load 'P'. What is the maximum stress induced in the bar?

Ans
1. 

           

2. 

            

3. 

4. 

           

Q.75 For a cantilever beam of length 'L' subjected to a uniformly distributed load (UDL) w
(kN/m) over its entire length, what is the bending moment at the fixed end?

Ans
1. 

           
           

2. 

           
           

3. 

            
            

4. 

           

Q.76 Which type of scaffolding is most suitable for stone masonry work?
Ans 1. Single scaffolding

2. Cantilever scaffolding

3. Suspended scaffolding

4. Double scaffolding



Q.77 What is the primary load that a lintel resists?
Ans 1. Shear load

2. Bending load

3. Axial load

4. Lateral load

Q.78 The quantity of flooring is measured in:
Ans 1. m3 and the length, breadth and height are taken as outside dimensions from wall to wall of superstructure

2. m2 and the length and breadth are taken as inside dimensions from wall to wall of superstructure

3. m2 and the length and breadth are taken as outside dimensions from wall to wall of superstructure

4. m3 and the length, breadth and height are taken as inside dimensions from wall to wall of superstructure

Q.79 What is the primary function of a pile cap in a deep foundation?
Ans 1. To reduce the length of piles

2. To prevent water ingress into the foundation

3. To distribute loads evenly among piles

4. To improve aesthetic appearance

Q.80 If the retaining wall moves away from the backfill, the value of coefficient of Rankine's
earth pressure is given by:

Ans 1. (1 − sin φ)

2. (1 + sin φ)

3. 

4. 

Q.81 What happens when the rate of precipitation is greater than the rate of infiltration?
Ans 1. Rivers and lakes start to evaporate faster

2. Groundwater recharge occurs

3. Evaporation stops completely

4. Surface runoff increases

Q.82 The basic principle of surveying, 'working from whole part', is best represented by
which of the following options?

Ans 1. One can finish the traverse survey quickly.

2. If an accurate basic control is established first, large errors can be prevented and minor ones controlled and localised.

3. Easiness in surveying.

4. It helps to continue the work during the second day of surveying.

Q.83 Which fastening system is commonly used with concrete sleepers in Indian Railways?
Ans 1. Elastic Rail Clip

2. Dog Spike

3. Fang Bolt

4. Fish Plate

Q.84 Identify the tool NOT used for stone dressing:
Ans 1. Splitting chisel

2. Pestle

3. Mash hammer

4. Dressing knife



Q.85 Which soil type is least suitable for shallow foundations?

Ans 1. Silty clay

2. Fine sand

3. Black cotton soil

4. Coarse sand

Q.86 The pointing that facilitates easy draining of water is ______.
Ans 1. beaded pointing

2. recessed pointing

3. tuck pointing

4. struck pointing

Q.87 Which of the following is NOT an effect of a force applied to a body?
Ans 1. Change in direction of motion

2. Change in shape

3. Change in mass

4. Change in motion

Q.88 As per IS 10262:2009, what is the maximum mixing water content per unit volume of
concrete for 20 mm nominal maximum size angular coarse aggregate, considering a
slump range of 25 to 50 mm?

Ans 1. 186 kg/m3

2. 250 kg/m3

3. 200 kg/m3

4. 150 kg/m3

Q.89 Which of the following commands is used in Autodesk 3ds Max to create a new scene?
Ans 1. Edit -> New Scene

2. Create -> Scene Setup

3. File -> New

4. File -> Open

Q.90 Which is the correct sequence for preparation of the surface for new pointing work?
Ans 1. Wetting surface and joints; Raking Joints; Cleaning surface and joints

2. Cleaning surface and joints; Raking joints; Wetting surface and joints

3. Raking joints; Cleaning surface and joints; Wetting surface and joints

4. Cleaning surface and joints; Wetting surface and joints; Raking joints

Q.91 Which of the following statements are correct with respect to estimation of water tanks?

A: Water proofing compounds are added in plaster of water tank walls.
B: Item particulars in estimate of water tanks, does not include estimate of ladder to be
built around it.
C: When the vertical and horizontal walls of tanks meet, a sloping structure is built at
their intersection, this is called haunching.
D: When the vertical and horizontal walls of tanks meet, a sloping structure is built at
their intersection, this is called soling.

Ans 1. A and D

2. B and C

3. A and C

4. B and D



Q.92 What is a particle board made up of?
Ans 1. Layers of odd number veneers glued under pressure

2. Wood fibres and synthetic resin moulded together

3. Strips of thin wood glued between two veneers

4. Wood chips in a binder pressed under heat/pressure

Q.93 Half round country tiles are laid in pairs of _________.
Ans 1. lap tile and overlap tile

2. bottom tile and crown tile

3. under tile and over tile

4. base tile and covering tile

Q.94 How does adding more fine aggregate affect the properties of Ready Mix Concrete
(RMC)?

Ans 1. Improves compressive strength directly

2. Enhances resistance to freezing and thawing

3. Increases setting time

4. Increases workability

Q.95 How is the design shear strength of concrete (c) influenced by the percentage (pt) of
tensile reinforcement in a beam?

Ans 1. Decreases with an increase in tensile reinforcement percentage

2. Increases up to 2% of tension reinforcement and decreases if the tension reinforcement exceeds 2%

3. Increases with an increase in tensile reinforcement percentage

4. Remains constant regardless of tensile reinforcement percentage

Q.96 In a singly reinforced beam, the reinforcement is provided in which zone?
Ans 1. Entire cross-section

2. Both tension and compression zones

3. Only tension zone

4. Only compression zone

Q.97 Which of the following states in India has the maximum potential for wind energy?
Ans 1. Punjab

2. Gujarat

3. Himachal Pradesh

4. Uttar Pradesh

Q.98 Shooting concrete under pressure with hose pipe and nozzle to repair damaged
concrete areas is known as _____.

Ans 1. curing

2. sealing

3. concreting

4. guniting

Q.99 In planning a residence, the principle of orientation is adopted to ensure:
Ans 1. beautiful aesthetic appearance of the residence

2. rooms are oriented to achieve the required privacy

3. natural elements are used effectively in the design

4. proper sanitation and hygiene in the residence



Q.100 Which of the following environmental factors negatively affects the durability of
concrete?

Ans 1. High temperature and humidity variations

2. Dry conditions with proper curing done

3. Stable temperature with no moisture changes

4. Well-ventilated surroundings
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